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Schematics in muddyboots.online 

This document provides users the information that is required to create and edit schematics in the 
muddyboots.online (MBO) app. Supplemental information on the purpose and meaning of schematic status 
types is also included. 

 

Creating an Empty Schematic 

• Under the  drop down, located under the  heading, click  to load the 
fields table.  

• Select the Field where the schematic needs to be built, by clicking the field name in the table. 
▪ Use the search bar in the top right corner of the table to search for the required field. 

▪ If the required field is not present, it can be added using the  selection located 

under the  portion of the  dropdown.  

 

•  Click the  to add an Empty schematic to the current field. 

 

•  Enter the Schematic name for the new schematic. 
▪ Remember: Follow the companies naming convention. 

• Click the  button to create an empty schematic. 
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Edit Mode Navigation 

This Section will explain the functions of the various menus and toolbars contained in the schematic edit tool. 
There are 4 areas that are used while editing or creating a schematics within the MBO application. These areas 

are the,  MBO Action Buttons,  Schematic Toolbar,  Schematic Elements Library and, Format 
Panel. 

If starting a schematic from scratch follow the steps in “Creating an Empty Schematic” to start.  

Tip: The best way to learn what the different buttons do, in the edit window, is to hover and read the tooltip, 
and never be afraid to click and experiment with the system. 

 

•  The “MBO Action Buttons” contain multiple buttons that affect the schematic as a whole. 

▪  The delete button is used to delete a schematic. The system will prompt to confirm 
the deletion of the schematic. After confirmation, the schematic will be permanently 
deleted from the system.  

• Verified schematics can not be deleted by MBO users. MBO will need to be 
contacted to delete previously verified schematics. 

• Note: Equipment will not be deleted from the MBO database when a schematic 
is deleted. 

▪  The Notes button is used to view or add notes to a schematic.  

▪  The Verify button, once clicked, will check to confirm that all flow lines on a 
schematic have been connected. If lines are not connected the system will highlight 
them in red. 
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▪  The “Viewer” button is used to navigate from the edit mode to the view mode.  

• Remember: Save any work that has been completed before navigating away 
from the edit mode or all changes will be lost. The system will prompt the user if 
navigation is attempted without saving. 

▪  The “Equipment” button will display a table of all the equipment on the open 
schematic 

• Tip: This list can be exported to an Excel spreadsheet.  

▪  The “Sites” button will display a table of all the sites on the schematic. 

▪  The “History” button will load a list of all the changes made to a schematic in 
historical order. Once a schematic has been verified by the “Schematic Verifier”, 
historical versions of the schematic can be viewed under the history portion of the 
schematic tool. 

•  The Schematic Toolbar contains functions for tasks related to editing the schematic. Some of these 
functions are duplicated in the Format Panel and can be completed from both areas depending on user 
preference.  

▪  The save button 

▪  The “Undo” and “Redo” buttons can be used to undo mistakes or redo an undo 
between saves. 

• Note:  These buttons will only work between saves. Once a change has been 
saved it can not be undone using the “Undo” arrow.  

▪  The eraser button will remove the equipment from the schematic, but keep the 
equipment in the master database. The equipment can be added to schematics in the 
future if required.  

▪   The trash can button will permanently delete equipment, and all the data 
associated with it, from the MBO database.  

o Tip: If equipment is unintentionally deleted, use the “Undo” button 
before saving the schematic. Once the schematic is saved the equipment 
will be deleted from the database.  

▪  The view button can be used to toggle the “Format Panel” and the “Outline” 
window 

• Turning off the “Format Panel” and/or the “Outline” window will allow the users 
to have more space to work in the schematic tool.  

• Note: The format panel will be open by default. 

▪  The zoom selection buttons can be used to select the level of zoom 
on the schematic 

• Use the “Zoom %” dropdown to select a pre-determined zoom level 

• Use the magnifying glass buttons to zoom in and out. 
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• Using the “+” and “-“ keys on the keyboard will zoom the schematic in and out 
respectively 

• Tip: Holding the shift key and scrolling with the mouse scroll, will change the 
displayed zoom on the schematic. 

▪  The “Center” and “Middle” buttons are used to align multiple selected 
equipment on the vertical and horizontal planes respectively. 

• To align equipment vertically, click the  button.  

• To align equipment horizontally use the  button 

• Note: These functions are present in the “Format Panel” as well as by using key 
shortcuts. This explained in the “Aligning Equipment” portion of this document. 

▪  The PDF button will export the schematic to PDF format for printing or saving to an 
internal location.  

• Best Practice: MBO advises that the default 11x17 paper size format be used for 
best fit and the schematics be printed on 11x17 paper.  

▪  The Legend button will open the schematic legend. 

• The schematic legend will only show equipment and flow line types that have 
been added and saved to the open schematic.  

▪  The line format button will allow users to change the type of line used.  

• For lines that attach to schematic elements horizontally (arrow facing left or 

right) use the  “Horizontal” line type. This will make up 90% of the lines drawn 
in the system 

• For lines that attach to schematic elements vertically (arrows facing up or down) 

use the  “Vertical” line type 

• Note: The default line type is “Horizontal” however a selected line format will 
remain for all subsequent lines drawn on the open schematic after making a 
different selection. 

• Best Practice: MBO advises that only “Horizontal” and “Vertical” line type be 
used. Other line types should be avoided as they often make schematics difficult 
to update in the future and can cause arrow display problems. 

▪  The product selection provides flow product selections to change the flow 
product displayed on the schematic flow lines.  

• Select the lines that need to have their product type changed, click the  
button and select the correct product from the resulting drop down. 

• Note: Product lines will always default to “Gas” 

•  The “Schematic Elements” Library allows user to select or search for schematic elements to add to 
the schematic.  

▪ Click a heading to expand and view the schematic element selection  
▪ Use the “Search Schematic Elements” box to quickly find schematic elements to add 
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▪ The Schematic Element selection menu will be covered in more depth in the “Building 
and Editing Schematics” portion of this document.  

•  The Format Panel is a dynamic menu that changes depending on what has been selected on the 
schematic grid. Many of the functions in the Format Panel are more in-depth functions from the 
Schematic Tool Bar.  

▪ With Nothing selected on the schematic the “Diagram” options will be available in the 
format Panel.  

• Users can change the “View” to show a grid on the schematic, or show the page 
margins by selecting “Page View” 

• “Guide” lines can be toggled on or off. 
▪ Paper size and print orientation can be selected under the “Paper Size” portion of the 

menu. 
▪ Selecting one or multiple schematic elements will toggle “Style”, “Text” and “Arrange” 

option tabs. The options under each tab will change depending on the schematic 
elements that have been selected.  

• The format panel will be covered in more depth in the “Building and Editing 
Schematics” portion of this document.  

 

Building and Editing Schematics 

This section will cover building and editing schematics.  

To begin follow the instructions to create a blank schematic or navigate to an existing schematic and click the 

 edit button in the top right corner of the screen. If possible, clone a similar, existing schematic, to save 
time when building new schematics. Please contact MBO for Schematic Cloning instructions. 

(a) Adding Equipment 

Expand a schematic element category to view the schematic elements. Schematic element menus are 
broken out by type category. Remember: Schematic elements can also be searched for using the “Search 
Schematic Elements” box. 

The following example will use the “Well heads” schematic element category. 
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•  Hover the mouse over a schematic element to view the schematic element name 
▪ Click and drag the schematic element on to the schematic.  
▪ Single clicking Schematic Elements will place them on the bottom left portion of the 

schematic.  
 

 
• Once a Schematic Element has been placed on the schematic, an Equipment Details window will 

automatically open containing a form to fill out with Equipment Details.  
▪ Every schematic element has 2 mandatory fields that need to be filled out in order to 

save the schematic. These required fields are shown in the picture above as and . 
▪ The remaining Equipment Details can be filled in while building the schematics or 

imported to the system after the schematic has been built.  
▪ Every schematic element will have different details that can be filled out.  

•  The “Equipment Name” field should be filled out following with the companies naming convention 
for the equipment being added to the system. This box cannot be blank. 

▪ Note: Wellheads will show “Well Identifier” instead of “Equipment Name” as shown in 
the above example. 

•  The Surface Location box should be filled out with information regarding the physical location of 
the equipment.  

▪ This information can be in the forum of an LSD, GPS Coordinate or a written description. 

• Best Practice: When possible, enter LSD or GPS coordinates. 
▪ If the Surface location has already been added to the MBO Software it will automatically 

be populated into a dropdown list when 2 or more characters from the Surface Location 
have been typed in the box.  

▪ New Surface locations will automatically create sites in MBO once the schematic has 
been saved. 

▪ Tip: If adding a new Surface location, save the schematic once the equipment has been 
created to ensure that the selection populates into the drop down for subsequent 
equipment with the same Surface Location.  

• Once all the required information has been filled out, click the  button located at the 
bottom of the equipment details window.  
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(b) Aligning Equipment/Moving Equipment 
It is best practice to align Schematic Elements vertically and horizontally. This keeps the schematics easy to 
follow. Schematic Elements can also be moved in order to show flow or reduce white space. 

 

•  Select the equipment that needs to be aligned, starting with the reference equipment. In the 
example above, the “Wellhead – Gas – Gaspump” is the reference piece of equipment that the valve 
and separator will be horizontally lined up in the center of. 

▪ Multiple pieces of equipment can be selected by holding the Ctrl key on Windows or the 
Cmd key on Macs and clicking the target equipment. 

•  Click the  button to align the equipment on a horizontal plane.  
▪ There are additional align selections located under the Arrange tab of the Format 

Pannel, in the “Align”   portion of the “Format Panel”. 
▪ This can also be accomplished by using the keyboard shortcut Ctrl+m on Windows or 

Cmd+m on Macs 

• To align equipment on a vertical plane, follow steps  and  above, but use the  button.  
▪ This can also be accomplished using the keyboard shortcut Ctrl+e on Windows or Cmd+e 

on Macs or the additional align selections in the “Format Panel”. 

• Once equipment has been placed on the schematic, it can be moved using different techniques.  
▪ Click and Drag – Click and drag equipment to different positions on the schematic. 

• If “Guides” are turned on, blue lines will appear to show how schematic 
elements are located in relation to other schematic elements, while dragging. 

▪ Click and arrow keys – Equipment can be selected and moved using the arrow keys on 
the keyboard. Press the arrow keys to move equipment 1 pixels, hold shift and press the 
arrow keys to move equipment 10 pixels. 

• This is helpful when making small orientation adjustments or straightening lines 
on the schematic.  

• Multiple pieces of equipment can be moved at once using the above techniques by selecting multiple 
pieces of equipment using drag and highlight, or holding the Ctrl key on Windows or the Cmd key on 
Macs and clicking multiple pieces of equipment. 
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(c) Distribute Equipment 
To evenly space equipment, use the Distribute function located under the Arrange tab of the Format Panel.  
 

 
 

•  Select the equipment to be distributed.  
▪ Equipment can be selected by holding the Ctrl key on Windows or the Cmd key on Macs 

and clicking the target equipment 
▪ Equipment can also be selected by highlighting the target equipment.  

• To highlight, click and drag over the target equipment. 
▪ Note: Equipment was aligned in the “Align Equipment” portion of this document 

•  Click the  tab in the “Distribute” portion of the “Format Panel”. 

• To perform the distribute function on the vertical plane, follow the steps above but use the 

 button.  
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(d) Connecting Flow Lines 
Note: Equipment has been distributed using the Distribute function covered in the “Distribute Equipment” 
portion of this document 
 

 

•  Hover the mouse over a Schematic Element to see the connection points, the blue “x” that appears 
around the perimeter of the Schematic Element. A green circle indicates that the mouse is hovering 
over a connection “x”. 

• Click a connection point and drag to start drawing a line. 
 

 

•  To connect a flow line, drag the line to a corresponding connection point on a Schematic Element.  
▪ A green circle will appear when a connection has been made. 

• Release the mouse button to drop the line. 
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•  Click on the  located in the middle of a line to reposition the line. 

▪ Horizontal Line types  can be moved left and right. This will be the majority of the 
lines drawn 

▪ Vertical line types  can be moved up and down. 

• Clicking any of the  blue dots when a line is selected will allow the user to change the lines 
orientation.  

 

 
• The above picture shows the flow line moved to the right to clear the “Wellhead - Gas – Gaspump” 

title.  

• After all Flow Lines have been connected and the schematic has been saved, click the  button in 
the “MBO Toolbar” to verify that the lines are connected. 

▪ Lines that have not been connected correctly will appear in red, indicating that they 
need to be connected correctly. 
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(e) Changing Flow Line Product Types 
The default product line type is “Gas”. It will be necessary to change the line type to correctly display the 
product flow. 
 

 

•  First select the flow lines to be updated to the correct product.  
▪ Multiple flow lines can be selected by clicking each line while holding the Ctrl key on 

Windows or Cmd on Macs. 
▪ Flow lines can also be selected by clicking on white space and dragging the selection 

window over the target flow lines 

• Note: Highlighted equipment will not be affected by the product selection. 
▪ If all lines on a schematic are required to be changed to the same product type all lines 

can be selected by using the keyboard shortcut Ctrl+a on Windows or Cmd+a on Macs.  

• TIP: To select only the flow lines on a schematic select “Select Flow Lines”, 
located under the “Edit” Drop down of the “Schematic Toolbar” or use the 
keyboard shortcut Ctrl+Shift+E on Windows or Cmd+Shift+E on Macs. 

•  Click on the  selection and select the desired product type from the product list. In the 
example “Full Well Stream” will be selected. 
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(f) Flow Line Jumps 
Often flow lines will intersect each other. To make it easier to distinguish flow, users can apply line jumps. 
 

 

•  Select the flow line or lines that “line jumps” need to be applied to by clicking on the line or 
selecting multiple lines. 

•  With a line, or multiple lines selected, enter the “Style” portion of the “Format Panel” 
▪ Select the line jump style from the dropdown box. Selections include “None”, “Arc”, 

“Gap” and “Sharp”  
▪ Select the line jump size, in pixels by clicking the up or down arrows on the “line jump 

size” box. 
▪ Note: Once line jumps are turned on, any subsequent line that is drawn will 

automatically have line jumps applied 

• Note: The line that is on the top or front will jump. See below on how to move Schematic Elements to 
Front/Back 
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(g) Moving Flow Lines and Equipment Front to Back 
Flow lines will often need to be rearranged to display the lighter product on top or jumping over lines 
carrying heavier products. Occasionally equipment will need to be brought to the front so that text is not 
obscured by flow lines.  
 
The example below shows a Separator and a Condensate Line that will be brought to the front in order to 
display the Separator text on top of the water flow line and create a jump in the condensate line.  

 

•  Select single, or multiple schematic elements that are required to be moved forward or back.  
▪ In the example, both the “Separator” and the “Condensate” line are required to moved 

forward 
▪ Remember: When selecting multiple schematic elements, all selected elements will be 

affected the same way 

•  Enter the “Arrange” tab of the “Format Panel” and select the  button to bring 

elements forward. Select the  button to move elements behind.  

• Schematic elements can also be moved forward or back by selecting a schematic element, right clicking 
on the selected element and selecting “To Front” or “To Back” from the resulting menu.  
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(h) Additional Format Panel Functions 
Remember: The “Format Panel” is a dynamic menu, so selecting different schematic elements displays 
different options on the Format Panel tabs. 
Style Tab – Primarily used for line jumps and text boxes, the style menu contains options for “line jumps” 
on flow lines, background toggle for equipment and line styles/fill options for delineators and text boxes 
Text Tab – Text options for all schematic elements are located under the text tab. The text size, position 
and format can be edited similar to Microsoft Office products. 
Arrange Tab – Contains options for manipulating schematic elements. This includes moving schematic 
elements forward or back, size adjustment in pixels using manual entry or button clicks, position 
adjustment using manual entry or button clicks, angle adjustments using manual entry or 90° increments, 
Flip options, copy size/paste size options, align options and distribute options.  
 
 
 

(i) Linking Flow Arrows Across Schematics 
To quickly follow flow from schematic to schematic and perform the “Equipment Upstream” and 
“Equipment Downstream” functions, the schematics must be linked using the “Flow Out” and “Flow In” 
arrows. This will help users visually see how products flow between schematics.  
 
Flow arrows must be placed on the schematics before they can be linked. Place a “Flow Out” arrow 
equipment type when a product is flowing away from a specific schematic and place a corresponding “Flow 
In” arrow equipment type on the schematic where the product flows to. Flow arrows are typically named 
with a description of where they are flowing to or where they are flowing from. 

 

•  After a flow arrow has been placed, the document must be saved in order to pair the flow arrow 
▪ Note: Both the “Flow Out” arrow, and the corresponding “Flow In” arrow must be 

created and saved in the MBO system before linking can occur.  

•  Double click on a saved flow arrow to open the Equipment Details window. 
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•  In the “Paired With” search for equipment box, start to type the corresponding name or site 
name/surface location of the flow arrow. Select the correct corresponding flow arrow name from the 
resulting list.  

▪ Note: “Flow In” arrows can only be paired with “Flow Out” arrows and vise versa. There 
is a 1 to 1 relationship with the arrows, multiple “Flow Out” arrows can not be paired to 
1 “Flow In” arrow and vise versa  

• Click the   button to finish pairing the flow arrows.  
▪ Tip: Save the schematic after pairing each flow arrow, this will prevent accidentally 

pairing a corresponding arrow twice. Only arrows that are not paired will show up the 
“Paired With” search menu.  
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(j) Updating Equipment Types in Edit mode 
Equipment type changes can be done from the schematic edit window. If the equipment type has changed 
but the data associated with that equipment needs to be retained, it is possible to update the equipment 
symbol from the schematic editing tool. This function will mostly be used for the wellhead equipment type, 
which will be used in the example below. 

 

•  Click and drag the new equipment type from the “Schematic Elements” menu. 
▪ Only schematic elements in the same category can replace existing schematic elements. 

For example, wellheads can only be updated to wellheads, meters can only be updated 
to meters, ext. 

•  Drag the selected schematic element so that the mouse cursor falls on the middle of the 

equipment to be updated. A  symbol indicates that the schematic element symbol will be updated. 
▪ Remember: This method only updates the “Equipment Type” in the MBO system. This 

will retain any equipment details, or operate data if there is operate data present. 
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(k) Finishing a Schematic - Best Practices 
Once a schematic has been edited or created, finished and saved, the following recommended best 
practices ensure that the schematic will provide maximum benefit for all users.  

• Export the schematic to PDF using the  button and check the PDF to make sure there is not excess 
white space present on the schematic print out.  

▪ If there is excess white space on the bottom of the schematic, try and compress the 
schematic horizontally, if possible.  

• If the schematic can not be neatly compressed horizontally, move the entire 
schematic into the center of the page by moving the schematic elements down 
until the white space is even top and bottom.  

• Remember: Ctrl+a on Windows or Cmd+a on Macs selects all equipment. Use 
Shift+arrow keys to move the schematic elements down. 

▪ If there is excess white space on the right of the schematic, try and compress the 
schematic vertically, if possible.  

• If the schematic can not be neatly compressed vertically, move the entire 
schematic into the center of the page by moving the schematic elements to the 
right until the white space is even left and right. 

• Remember: Ctrl+a on Windows or Cmd+a on Macs selects all equipment. Use 
Shift+arrow keys to move the schematic elements right. 

▪ Save the schematic. 

• Click the  button in the MBO toolbar to ensure that all flow lines are connected.  
▪ Correct any unconnected lines that will be highlighted in red, if present, and re-check for 

connections. 
▪ Remember: Lines must be connected in order for the “Upstream Downstream” 

functions to work correctly.  

• Turn on the “Tool Tips” to display equipment details when the mouse is hovered over equipment on 
the finished schematic.  

▪ Under the “View” menu in the “Schematic Toolbar” click the “Tooltips” selection to turn 
on “Tool Tips” 

• Take a final look at the schematic, double check that equipment is present and placed correctly, flow is 
represented correctly, and equipment is aligned as much as possible. 

Click the  button to load the “Sites on Schematic” page. Double check that all sites have been 
correctly entered into the MBO system. 
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Creating a New Schematic via Cloning an Existing Schematic 

This section will cover cloning existing schematics for quickly generating a ‘Typical’ or similar flow diagram.  

 

• To Clone an existing schematic, begin by determining the equivalent / near equivalent schematic you 
wish to use as the template for the new flow diagram. 

o Note: Copy the Name of the schematic to be used as this will be required for choosing the 
schematic to clone 

•  Navigate to and click ‘Clone’ under the Schematics dropdown. 

 

•  Name the new schematic. 
o Note: The name of the schematic does not affect the name of the surface location(s) where the 

equipment assets are located. 

•  Choose the schematic you wish to clone. Search by typing or pasting the name of the schematic 
you wish to copy.  

•  Choose the field where the new schematic will be located. 
o Note: The field list choice will be limited to the hierarchy currently set. In the image above, this 

is the ‘Canadian Operations’ Area that contains the ‘Wapiti’ field. 

•  Once satisfied with settings in the first three boxes, click  to move to the next step.  
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•  Select the surface location that the cloned schematic equipment will be created on. Existing sites 
within the previously selected field will be available and a note will be included if there is already 
system equipment on the sites, noted by ‘On a Schematic’ 

o Note: Choose ‘Create a new site’ if the surface location does not currently exist. 
 

WARNING! If the same surface location as the schematic being cloned is chosen, the equipment is not 
duplicated but rather the current schematic equipment is displayed again on the new schematic. 
Please confer with your muddyboots representative on the implications of ‘duplicating’ the same 
schematic. 

 

•  Click  to move to the equipment mapping stage. 
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•  At this stage, you are given options for each piece of equipment being cloned. 

 
o Create on new schematic: Clones the equipment to the chosen surface location and places on 

the schematic as is. 
o Don’t create on new schematic: Does not clone the equipment and leaves a blank space on the 

new schematic. 
o Equipment choice list: The choice of any existing equipment on the surface location of the new 

schematic is available and each unique asset can be selected to swap out for what would 
otherwise be cloned. 

▪ Note: This is typically used where a well list has already been loaded and can be placed 
on the new schematic. 

•  Click  to complete the schematic cloning process. You will now be redirected to view the 
new schematic created. 
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Schematic Company Summary, Management, and Definitions 

Depending on your regulatory body, flow schematics need to be maintained and annually verified to remain in 
compliance. Muddyboots integrates schematic status elements to ensure compliance is met and non-
compliant flow diagrams can be easily managed. Schematic management begins with understanding of the 
schematic status’s and how they are controlled within the MBO platform. 
 

(a) Schematic Company Summary 
 
A company summary of schematic status, changes, and review requirements is available under the 
main Summary dropdown. The schematic summary lists the current state of all schematics, the 
previous 2-months changes and requirements, along with a granular summary of individual flow 
diagrams requiring attention.  
 

 
 

•  Monthly Summary 
o Displays the current months flow diagram summary, with quick links to filtered links for easy 

management of any ‘non-verified’ schematics: Expired, Unverified, and Never Verified. 
o The previous months summaries are also available to view a unified changelog. 

•  Needs Attention Summary 
o A granular summary of all schematics that need attention due to moving into an unverified or 

expired status.  
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(b) Schematic Status Management 
 
New schematics will have an original status of Never Verified, these schematics will have to be actioned 
to either verify the diagram or to Inactivate the schematic to remove the diagram from email 
subscriptions and verification requirements. 

 
 

•  When viewing a schematic, click  to expand the Action dropdown menu. These options 
are only available for those users with the Schematic - Verifier system access role. 
 
This menu will display the following information and options: 

o A note on the schematic status. 
o Recent schematic history, with a link to the complete list of schematic changes. 

o  Verify Schematic options: 
▪ This option allows verification of the schematic with the production month selectable 

and noted for review. 

▪ Type VERIFY, and click  to record a verification. This will verify the 
schematic for 12 months from the day it was verified, after 12 months the schematic 
moves into and Expired status to be re-verified. 

▪ If Schematic Workflows have been enabled, the workflow for schematic verification will 
be present in place of typing the word VERIFY. Review Workflow Quickstart 
documentation for more information. 
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o  Inactivate Schematic options: 
▪ This option updates the schematic status to Inactive, thereby removing the schematic 

from subscriptions, verification requirements, and other schematic interfaces. 

▪ Type INACTIVATE, and click  to update to an Inactive status. 
Note: An Inactivated schematic can be reactivated 

o Reactivate Schematic Options 

 

▪ If an Inactive schematic needs to be reactivated, open the  panel, type 

REACTIVATE, and click . This will give the schematic in an Unverified status. 
 

 

o  Unverified and Expired Schematics 
▪ Unverified and Expired schematics both require verification but reached that 

requirement in two distinct ways. 

• Unverified schematics have been altered in some way and now have a single or 
many changes applied to them. 

• Expired schematics have gone beyond the verification period of 12 months and 
now require a review and verification. 

▪ Historically verified schematics and a full history of schematic changes can be reviewed 

under the schematic . 
Note: If schematic Workflows have been setup for verification purposes, Expired schematics 
will automatically initiate a workflow with email notification that will require attention to 
complete the verification process. 
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(c) Schematic Status Types and Definitions 
 
Never Verified – This is a schematic that has not been expressly verified by a user with the Schematic 
Verifier System Role. This is typically the status of new schematics that have been recently built and 
require a review to ensure correct layout, flow, assets, etc. 
 
Verified – A Verified schematic has been expressly verified by a user with the Schematic Verifier access 
role. A verified schematic remains in a verified state for 1 year from date verified, with the Production 
Month noted. All verifications of a single schematic can be viewed on the schematic History page, and 
each verification can be viewed to see the previous iterations of the flow diagram. If any changes occur 
on the schematic prior to the 1-year period ending, the schematic moves into an Unverified State. If no 
changes occurred within the 1-year period, after the year the schematic state is updated to Expired. 
 
Unverified – An Unverified schematic is a schematic that was previously verified but has been modified 
since the verification was completed and prior to the schematic expiring. All changes made since the 
previous verification can be viewed on the schematic history page. 
 
Expired – An Expired schematic is a flow diagram that was last verified >1 year previous. The Flow 
schematics move to an Expired status to meet AER Directive 017 compliance guidelines. 
 
Inactive – An Inactive schematic is one that should no longer be used, and the status has been 
expressly set to Inactive by a user with the Schematic Verifier role. Schematics with this status will be 
excluded from subscription news, and other interfaces that use schematics. Related equipment will not 
be impacted. 
 
 

  


